Outline
About this reference guide.............................................................................................................................................................................. 2
Open Dreamweaver ..................................................................................................................................................................................... 2
Workspace Setup .......................................................................................................................................................................................... 2
   Prefer the view from previous versions of Dreamweaver? .................................................................................................................. 3
Main Screen.................................................................................................................................................................................................... 4
Recommendations for Software Setup .......................................................................................................................................................... 4
   Toolbars..................................................................................................................................................................................................... 4
   Layout Tools ........................................................................................................................................................................................... 5
   Properties panel for formatting .......................................................................................................................................................... 5
      New Dreamweaver CS4 – toggle between <>HTML and CSS ...................................................................................................... 5
   Default Browser..................................................................................................................................................................................... 6
Keyboard Shortcuts ................................................................................................................................................................................................ 7
   Popular shortcut commands.................................................................................................................................................................... 7
Document View/Design Choices .................................................................................................................................................................. 7
   Design......................................................................................................................................................................................................... 7
   Split.......................................................................................................................................................................................................... 7
   Code........................................................................................................................................................................................................ 7
   Live View.................................................................................................................................................................................................... 8
Creating a basic webpage............................................................................................................................................................................ 8
   Title your webpage.............................................................................................................................................................................. 8
   Modifying Page Colors / Fonts .......................................................................................................................................................... 8
   Formatting and Manipulating Text .................................................................................................................................................. 8
   Bold and Italic Print ........................................................................................................................................................................... 9
   Headings.................................................................................................................................................................................................. 9
Line Spacing .................................................................................................................................................................................................. 9
Save a webpage.................................................................................................................................................................................................. 10
   Asterisk * in file name ........................................................................................................................................................................ 10
   Saving several pages....................................................................................................................................................................... 10
   File extensions - html or htm?............................................................................................................................................................ 10
Have several pages open.............................................................................................................................................................................. 10
Bullets and Lists ................................................................................................................................................................................................ 11
   Lists........................................................................................................................................................................................................... 11
Dreamweaver Reference Guide

Insert Menu Options (for special characters, inserting images, creating hyperlinks) ................................................................. 12
  Classic Menu ..................................................................................................................................................................................... 13
  Special Characters ............................................................................................................................................................................. 13
Create hyperlinks to open other web pages, documents or email addresses .................................................................................. 15
  Create hyperlink to a web page ....................................................................................................................................................... 15
    Another way to link ........................................................................................................................................................................ 15
    Editing a link .................................................................................................................................................................................. 15
  Create hyperlink to a document ..................................................................................................................................................... 16
    Another way to link ........................................................................................................................................................................ 16
    Editing a link .................................................................................................................................................................................. 16
  Create email address hyperlink ....................................................................................................................................................... 17
    Another way to link ........................................................................................................................................................................ 17
    Editing a link .................................................................................................................................................................................. 17
Inserting Images ................................................................................................................................................................................... 17
Tables .............................................................................................................................................................................................................. 18
Meta tags – Make Your Pages Searchable ........................................................................................................................................ 18
  Adding Description .......................................................................................................................................................................... 18
  Adding Keywords ............................................................................................................................................................................ 19
  Edit meta tag info ........................................................................................................................................................................... 19

About this reference guide
This reference guide touches on common features used in web design. It is not intended to be all inclusive. Enrollment in web design classes or self study is highly recommended.

Open Dreamweaver
Faculty/Staff should find Dreamweaver by clicking Start- navigate to Specialized Software - Adobe - Adobe Dreamweaver.
If you do not have a site set up in Dreamweaver, you may receive a message indicating you need to set one up.
  • Faculty/Staff - see tutorial called “Set Up Your Site” at http://www.bloomu.edu/technology/web
  • Students – see tutorial called Student Guide – “Set up your site in Dreamweaver…” at http://www.bloomu.edu/technology/student/web

Workspace Setup
The default setup for CS4 is the designer mode.
Dreamweaver Reference Guide

To change it, select it from the menu bar. Pick one of the following:

**Designer** is tailored towards visual designing. This is the option most people will use. *(The screenshots in this tutorial were done using the Designer default.)*

**Coder** is tailored for programmers—those who want to work primarily with XHTML and other Web/programming languages.

**Designer Compact** is exactly the same as designer, but the menus are visually smaller, but contain all of the same functions.

**Coder Plus** contains all of the features that coder does, but adds another menu for working with CSS stylesheets and AP elements.

**Classic** is tailored for users who are very comfortable with the visual interface that was used in Dreamweaver 8 and Dreamweaver CS3. It is set towards the designer mode.

**App Developer** is tailored for application programmers—those who want to work primarily with items such as JavaScript and other Web/programming languages.

**App Developer Plus** is tailored for application programmers—those who want to work primarily with JavaScript and other Web/programming languages. Includes CSS Stylesheet menu and AP elements menu.

**Dual Screen** is tailored for users with dual screens. Designer mode is used as the look and feel.

**Prefer the view from previous versions of Dreamweaver?**
Dreamweaver CS4 has a different look and feel. If you prefer the layout offered with previous versions, click on the drop down next to the Designer button, and choose “Classic.”
After you choose the setup you desire, it can be changed at any time.

**Main Screen**

This screen can be used to create new pages.

You may open previously created pages by clicking the Open... button.  
Or click File – Open from top menu bar

Note: If you don’t care for this screen, you can click on the “Don’t show again” checkbox.

Note: If you get rid of this main screen, but then want it back, click Edit-Preferences. Use the General tab and put a checkmark in “show startup page.”

**Recommendations for Software Setup**

**Toolbars**

If you have not already started creating a new document, click File-New to create a new document.  
Click View-Toolbars and make sure “Document,” and “Standard” are available.
Layout Tools
Click Window and make sure to click on “Insert,” “Properties,” and “Files.” This will ensure the following screen features are available:

“Insert” provides tools in the form of shortcut icons, such as the ability to easily insert images, tables, etc.

“Files” ensures you are able to view your local site files in this panel.

“Properties” ensures a place to edit HTML and CSS.

Properties panel for formatting
If this isn’t open in your Dreamweaver screen, click Window-Properties to open it. This area allows you quick formatting options such as highlighting text and using the Bold or Italic features, centering, linking, changing colors, etc.

New Dreamweaver CS4 – toggle between <>HTML and CSS
The properties panel may be toggled between CSS and HTML.
Default Browser
As you create pages, you will be able to preview your webpage to see how it will look once it is published. You will have to save your page prior to previewing it. Preview by clicking on the “globe” icon.

By default, Internet Explorer is set as the primary web browser for previewing.
To change this, click on Edit-Preferences. Use the Category listing “Preview in Browser.”

Add a browser by clicking the + sign
Delete a browser by highlighting it and clicking the - sign

Highlight the browser you wish to use as your primary browser and click the checkbox in front of Primary Browser.
Keyboard Shortcuts

Familiarize yourself to keyboard shortcuts by clicking on Edit-Keyboard Shortcuts, which will show you all shortcuts available.

Popular shortcut commands

Use Control N to create a new XHTML page
Use Control S to save a page
Use Control Z to undo an action or keystroke
Press the Shift key plus the Enter key to force single spacing

Document View/Design Choices

There are three icons which allow a choice for how you wish to design your pages – Code, Split, or Design. A description of each follows ~ you can choose which option(s) work best for you!

Design

Using this option you will see no coding at all. This screen shows you an approximation of how the page will look once it is on the web. Note that this is only a guide to the visual characteristics of the page. To see how the page truly looks, use the Preview in Browser button found in the title toolbar.

Split

Using this option you will see a split screen. One portion of the screen shows XHTML code and another shows design view.

- It is often helpful to examine code if something isn’t working correctly.

Code

Using the option called Code, you will see code only.
Live View
New in Dreamweaver CS4, this is an option used for dynamic pages, such as those interfaced with databased or multimedia. A testing
server would need to be set up to use this feature.

Creating a basic webpage
Click File-New. Choose Basic Page.

Title your webpage
The toolbar directly underneath the text menus contains the Title toolbar. Enter the title for your page in the space provided.

Adding a title to your page is important! The title shows in the
Internet browser window once your page is published. If a title is
not added, the browser window would say "Untitled Page."

In addition, if someone bookmarks your page, their bookmark
will show the title.

Modifying Page Colors / Fonts
Click the Page Properties button in the Properties window to edit background color, specify different colors for fonts, links, etc. (This can
also be done by clicking on Modify and choose Page Properties from the menu bar.) Most page modifications should be done using the
<>HTML button.

Formatting and Manipulating Text
Use the Properties window to assist with formatting.
Dreamweaver Reference Guide

Bold and Italic Print
Similar to formatting options available in Word and Excel, the properties panel may be used for bolding and italicizing text, centering, adding bullet points, etc.

Headings
Make certain the Properties panel is defaulted to <>HTML to use headings!

Headings 1 through 6 are available under the Format dropdown.

Select a heading and type your text. If you forget to apply a heading to your typed text, highlight the text and choose heading.

➢ Use of headings greatly helps web visitors using screen readers. Screen readers read web pages to someone visiting a website. If a piece of text is identified as a heading, the screen reader will announce that it's a heading. If not, screen reader users won't be able to tell your headings from the rest of your text. They will have to listen to the page in its entirely rather than having the option to jump from one main heading to another.

Heading 1
Heading 2
Heading 3

Line Spacing
As you type, text will be wrapped automatically and you will have single spacing. Pressing the Enter key will insert a new paragraph and give you double spacing. To control spacing, i.e., if you wish to type a line and only want single spacing for the next line, follow these steps:

➢ Type a line.
➢ Press Shift key plus the Enter key. You will now control the spacing to be single spaced.

You may also use the BR feature under the Insert menu.

Insert-Text-BR symbol.

Press the Enter key when you are ready to insert a new paragraph.

7/22/2010
Copyright, Office of Technology, Bloomsburg University
Dreamweaver Reference Guide

Save a webpage

Your page will say “Untitled” with a number and a dash next to it until it is saved and given a name. When ready to save, click File-Save As (or hold Control key down and press S). Type a name for your page and click the Save button.

- Reminder: Home pages must be named index.html or index.htm
- Reminder: If your page name contains more than one word, type words together with no space, or add an underline between names. Examples: page1.html or page_one.html

Asterisk * in file name

An asterisk next to a file name indicates there have been changes made to the page and it needs to be saved. Once saved, the asterisk will disappear.

Saving several pages

Have several pages open? Save them all at once by clicking File-Save All!

File extensions - html or htm?

Either extension is fine to use but it is suggested you pick one and use that consistently. Lowercase is also suggested, i.e., index.html

Have several pages open

You may have the need to open several pages to work on them concurrently. Once they are open, you will see tabs available for the different documents you have open. You can switch back and forth by clicking on a tab.
Bullets and Lists

Lists

The circled items below assist with creation of lists. The most commonly used lists are UL (unordered lists, also known as bullet points) and OL (ordered lists, also known as numbered lists). Examples below and OL (ordered lists, also known as numbered lists).

Sample ~ UL

• computers
• desks
• chairs

Sample ~ OL

1. computers
2. desks
3. chairs

NOTE: To use lists, follow one of the following steps:

1) Type the list first. When finished, highlight all the text and use the list buttons.

2) Click on the list button and then begin typing your list. As you press Enter to go to the next item a new bullet point or number will be inserted for you.
Dreamweaver Reference Guide

Insert Menu Options (for special characters, inserting images, creating hyperlinks)

Dreamweaver CS4 has a new look and feel. Previous versions of Dreamweaver provided an easy to find Insert menu option that you could use by clicking View-Toolbars-Insert.

You may use those same features in CS4 but must go about it a little differently. When using Designer mode layout, they are available under the Insert tab.
Dreamweaver Reference Guide

Classic Menu
If you prefer the way these options were laid out in previous versions of Dreamweaver, click on the drop down next to the Designer button, and choose “Classic.”

You will now see the menu options appear along a line, easier to find.

The next several pages contain options you have available under the insert options. We will show the steps using the Classic option.

Special Characters
Click Text menu on the Insert Toolbar. You will see many features available to use, most of which are self-explanatory.

Don’t see Common tab?
Make sure you have set Dreamweaver to Classic by clicking the drop down arrow here!
abbc
If typing an abbreviation on your webpage, you can use the abbc button so when someone rolls their mouse over the abbreviation a little popup appears with what the abbreviation stands for.
➢ Type the abbreviation – highlight it and click abbc under the Text insert area (you may have to scroll down a bit to find it). A popup window will appear where you can type in the full meaning.

w3c
If typing an acronym on your webpage, you can use the w3c button so when someone rolls their mouse over the acronym a little popup appears with what it stands for.
➢ Type the acronym – highlight it and click the w3c button under the Text insert area (you may have to scroll down a bit to find it). A popup window will appear where you can type in the full meaning.

Special Characters or Symbols (last button on the toolbar)
Click on the little drop down arrow next to the last symbol on the line.

This is where you will find special characters, such as copyright or trademark. Here are just a few symbols you will find. Have fun experimenting!

© ® ™ £ — §
Create hyperlinks to open other web pages, documents or email addresses

A great formatting tool is the **Common tab**. This tutorial will cover the basic features you may use.

Create hyperlink to a web page

Add a hyperlink by typing a line of text. Highlight the word or phrase you wish to use as a link, and click the hyperlink icon under the Common tab.

The following window will appear:

![Hyperlink properties window](image)

- **Text** - Type the text you wish to appear as the link text.
- **Link** - Add the webpage link.
- **Target** – Leave blank unless you may wish the link to open in a new window. If that’s the case, use the drop down window and choose _blank_. (Note: Some browsers other than IE may not support this feature.)

Click OK when done. Your hyperlink is in place!

Another way to link

Highlight the text you wish to use and use the properties window – the link and target areas are indicated in the screen shot below.
Editing a link
Probably the easiest way is to use the properties window as illustrated in the screen shot above.

Create hyperlink to a document
Type a line of text. Highlight the word or phrase you wish to use as a link to a document, and click the hyperlink icon.

The following window will appear:

```
Hyperlink

Text: here
Link: file:///buad/data/Departments/OT
Target: _blank
Title:
```

Click OK when done. Your hyperlink is in place.

Another way to link
Highlight the text you wish to use and use the properties window – the link and target areas are indicated in the screen shot below. Click on the file folder icon in the properties panel to browse to the document you wish to link to.

```
Properties

Title: 
Link: http://example.com
Target: _blank
```

Editing a link
Probably the easiest way is to use the properties window as illustrated in the screen shot above. Edit the link under the link area.
Create email address hyperlink

Type your line of text. Example: Additional questions should be directed to Judy Ohl. Highlight the name and click the email link icon.

The following screen appears.

![Email Link dialog box](image)

- **Text** – Should contain the text you wish to appear as the link.
- **E-Mail** – Type the email address for the link.

Another way to link

Using the <>HTML portion of the Properties Window:

Type text and highlight it. In the link area, type the email address, preceded by the word “mailto” – Example: mailto:johl@bloomu.edu

![Properties window](image)

Editing a link

The easiest way is to use the properties window as illustrated in the screen shot above.

Inserting Images

Images must always be resized prior to adding them to a webpage!

- Images may be resized directly in Dreamweaver, or by using photo editing software.
Tables

Tables may be used for a variety of things.
- Displaying tabular data
- Controlling image and text placement
- Controlling page layout

Visit the “Tables” tutorial at http://www.bloomu.edu/documents/tech/web/tables.pdf for an explanation and hands-on tutorial!

Meta tags – Make Your Pages Searchable

Inserting meta tag information into your pages can assist with browser search engines and help people find your pages. The content you add is not visible to web visitors as it coding embedded in your pages for search purposes. (Note: Some search engines do ignore meta tags.)

The two main features commonly used are Keywords and Description. (Note: There are other meta tags that can be used to redirect pages, specify copyright info, or refresh pages after a certain amount of days.)

To insert meta tab info, click Insert > HTML > Head Tags > Keywords (or Description) or use the Insert Toolbar as shown below:

Adding Description

Using either method mentioned above choose adding Description. The description text is what will be displayed on the search engine page so write well!

Insert > HTML > Head Tags > Description

The following window appears – type your text – example
Adding Keywords

Keywords are descriptive words that assist people using search engines. Think of the way you search and use keywords you think would assist people in finding your web site. **Hint:** Separate words by commas, don't repeat words, keep the list short and specific to your site. Most reference books warn to only use 10-15 words tops.

Insert > HTML > Head Tags > Description

The following window appears – type your text – example below

![Keywords window](image)

**Edit meta tag info**

Probably the easiest way to edit meta tag info is to go into "split" view mode and make sure you scroll all the way to the top of your page. You will see the meta info on the screen. You may click right into the code view and make necessary changes.

![Code view with meta tag](image)